
GIF Construction Set  for Windows
by Alchemy Mindworks Inc.

GIF Construction Set for Windows is bookware. If you like it, please read Steven William
Rimmer's new novel The Order, ISBN 1-895268-02-8, published by Jam Ink Publishing.
See BOOKWARE.WRI for more information.

If you can't find The Order locally, you can order it by calling 1-800-263-1138 or 1-905-
936-9500. The cost is $6.99 plus shipping ($2.50 in Canada, $3.00 to the US, $4.50 
international). This order service can accept payment by Visa, Mastercard or American 
Express. Other ordering options are outlined in BOOKWARE.WRI.

We are:

Alchemy Mindworks Inc.
P.O. Box 500
Beeton, Ontario
CANADA
L0G 1A0

Users of GIF Construction Set for Windows  who have read The Order will be entitled to 
good karma and a way to shut off the beg notice. 

Also, please note that should you fail to support this program and continue to use it, a 
leather winged demon of the night will tear itself, shrieking blood and fury, from the 
endless caverns of the nether world, hurl itself into the darkness with a thirst for blood on 
its slavering fangs and search the very threads of time for the throbbing of your heartbeat.
Just thought you'd want to know that.

If you like GIF Construction Set for Windows, be sure to check out Graphic 
Workshop, QuickShow Light and the other Alchemy Mindworks shareware 



applications. See the end of this document for more information.

Avoid Having Your Heart Ripped Out
In addition to sending our leather winged demon of the night down to your digs to snack 
out on important parts of you should you fail to register this software, we are also 
prepared to do so if you contact us for technical support and ask questions which are 
answered in this document. We spent a lot of time writing this thing, and pretty well 
everything you should need to know about using GIF Construction Set for Windows  is in
here. Please consult it before you get in touch with us.

One of the things that really enrages our leather winged demon of the night is people 
asking why their 256-colour GIF files won't display correctly through a sixteen-colour 
Windows display driver. See the section on the About dialog later in this document to 
pass on being turned into demon chow over this.

The Unisys GIF Tax
Work on this application was started some months before the surprise announcement by 
CompuServe and Unisys that Unisys held a patent on the compression algorithm used by 
GIF files, and would be collecting a royalty on commercial applications which use the 
GIF format. Because the cost of administering this fee would have exceeded any profit 
we could have hoped to make by releasing GIF Construction Set for Windows as a 
conventional shareware application, we have chosen to release it as bookware. As of this 
writing, Unisys has indicated that it will explicitly exempted "not for profit" applications 
from payment of this fee -- it is our understanding that as we are not charging anything 
for the software itself, GIF Construction Set for Windows qualifies as such. Based on this 
exemption, it is our further understanding that neither Alchemy Mindworks or users of 
GIF Construction Set for Windows are required to pay a royalty to Unisys for the use of 
this software.

Introduction
GIF Construction Set for Windows is a powerful collection of tools to work with 
multiple-block GIF files. It will allow you to assemble GIF files containing image blocks,
plain text blocks, comment blocks and control blocks. It includes facilities to manage 
palettes and merge multiple GIF files together. It will make the extensions of the GIF 
specification work for you. Among its other functions, GIF Construction Set for Windows
can:

- Create transparent GIF files.
- Add, edit and delete comment blocks.
- Add non-destructive text to images as plain text blocks.
- Create multiple-image GIF files and simple animations.
- Serve as a fully-compliant Windows GIF viewer application.
- Be a GIF viewer "helper" application for a World Wide Web browser or Mosaic client.

You can use GIF Construction Set for Windows to create and modify GIF files with as 
many blocks as you require.



GIF Construction Set for Windows  requires a minimum of four megabytes of memory to 
run reliably, with eight megabytes preferable. Larger images may require more memory 
still.

Blocks in GIF Files
A GIF file usually consists of two blocks, to wit, a header and an image. However, the 
structure defined by the GIF 89a specification allows for GIF files which contain multiple
images, and several additional optional block types. These types are:

- Comment blocks, which can include text describing the image in question, defining its 
creator or copyright status or anything else you want to say about it. Comment blocks are 
not displayed as part of a GIF file.

- Plain text blocks, which specify text to be overlaid on an image. The position and 
colour of the text can be defined. Unlike merely adding text to an image with a paint 
program, plain text blocks don't damage the underlying image.

- Control blocks, which define image transparency and allow for user input. The 
transparency field of a control block will let you specify that one colour in an image or a 
colour used by the text in a plain text block is to be regarded as transparent by a GIF 
viewer, allowing the underlying image to be visible wherever it occurs.

- Application blocks, which allow private application data to be included in a GIF file. 
Application blocks can't be created or edited with GIF Construction Set for Windows , 
although they will be preserved if you open a GIF file which contains them.

Every GIF file begins with a header block, which defines the size of the screen the GIF 
files should be displayed on if possible, and an optional global palette. It's important to 
understand how palettes work in GIF files. A palette defines the colours to be used by any
images and plain text blocks in a GIF file. A global palette, defined by the header block 
of a GIF file, pertains to all the images in the file. Alternately, individual image blocks 
are permitted to have palettes of their own, called local palettes. 

Because most display devices are colour mapped, and can only work with one palette at a
time, attempting to display multiple GIF images, each with its own local palette, will 
usually leave you with something that looks like bad abstract art or the aftermath of an all
you can eat spaghetti dinner. As such, multiple image GIF files should have all their 
images referenced to the global palette of the file unless you have a compelling reason to 
do otherwise. GIF Construction Set for Windows  includes facilities to remap and dither 
images to a global palette.

GIF Construction Set for Windows  will let you open an existing GIF file or create a new 
one and add blocks, modify the various data fields of blocks and delete blocks. In the 
case of image blocks, it offers a number of image processing options to make assembling 
multiple image GIF files from a number of discrete images as practical as possible.



Running GIF Construction Set for Windows  
When you initially boot up GIF Construction Set for Windows , you'll see a list of all the 
GIF files in the \GIFCON directory of your hard drive. You can open a GIF file either by 
double clicking on one of the names in the list, or by selecting Open from the File menu. 
You can navigate to a different directory or drive either by double clicking on the drive 
and directory entries in the list of the GIF Construction Set for Windows application 
window or through the File Open dialog. 

If you click once on the name of a GIF file which has a Graphic Workshop thumbnail 
associated with it, you'll see a small version of the GIF file's first image in the application
window of GIF Construction Set for Windows. Thumbnails will be discussed in greater 
detail later in this document.

When you open a GIF file, the main application window of GIF Construction Set for 
Windows will list each of the blocks in the GIF file, beginning with the header. Clicking 
once on an image block will display a thumbnail for it. Double clicking on any block that 
GIF Construction Set for Windows  recognizes will call up a dialog to edit it. You can 
also edit a block by clicking on it once to select it and then clicking on the Edit button in 
the GIF Construction Set for Windows  button bar.

GIF Construction Set for Windows  does not allow application blocks or blocks of 
unknown types to be edited.

Editing the Header Block
You can modify the following fields of the header block of a GIF file:

- Screen width and screen depth: These are the dimensions in pixels of the screen the 
GIF file would like to be displayed on. They can be any value greater than zero. Note that
the screen dimensions do not affect the dimensions of images displayed from a GIF file, 
but they may affect where on your screen the images are placed in a fully compliant GIF 
viewer.

- Background: The background is the colour of the area around the images to be 
displayed if the images in question don't fill your screen. The background is actually a 
number drawn from the current global colour palette... if the palette is changed, the actual
colour displayed may change too. To change the background colour, click on the colour 
button in the Edit Header dialog and select a new colour. The number in the Background 
colour button is the actual palette index being used.

- Global palette: The global palette flag tells GIF viewers whether a GIF file includes a 
global palette. If you change this flag, GIF Construction Set for Windows  will look at the
GIF file you're working on to see if there are images which expect a global palette and 
prompt you accordingly. In most applications of GIF files, it's desirable to have a global 
palette.



You can save palettes from GIF Construction Set for Windows  to disk files and load 
them in as new global or local palettes. The size of the current palette is shown to the 
right of the Load button.

The Sorted flag of Edit Header box allows you to set the state of the sorted palette flag in 
the header of GIF files. This flag has no affect on how GIF Construction Set for Windows
displays images -- it may be of importance to other applications which read your GIF 
files.

Editing Image Blocks
The Edit Image dialog includes the following fields:

- Left and top: These fields determine where the image in question will be displayed on 
your screen relative to the upper left corner. The values are in pixels. 

- Interlaced: This flag determines whether the image in question will be stored interlaced
or normally. If you have enabled the Display Interlaced item in the Setup dialog this will 
affect how GIF Construction Set for Windows displays images. It will also change how 
images appear in applications which display them one line at a time. Interlaced images 
are commonly used in World Wide Web pages.

- Local palette: You can enable a local palette for any image block in a GIF file. By 
default, the palette for the image in question will be used. You can also load and save 
palettes, as in the Edit Header field. Be careful doing this... you might wind us with an 
image having very weird colours. The Load and Save buttons will only be active if you 
have switched on the local palette option. The number of colours in the current image 
palette will be displayed below the Local Palette switch.

The View button of the Edit Header dialog will display the image in question. 
Specifically, it will display it against a solid colour background -- grey by default -- with 
a set of purple guides indicating where the screen area defined by the screen width and 
screen depth fields of the current header block would fall. This assumes that your screen 
area and image are smaller than your screen. The background colour can be defined 
through the GIF Construction Set for Windows  Setup dialog, discussed elsewhere in this 
document. 

Note that the View buttons in the edit dialogs will not display an entire complex GIF file. 
They'll only display the current block. If your image does not display correctly, please 
read the section of this document that deals with the About dialog for a discussion of 
Windows screen drivers. Hit Esc or click the right button of your mouse to exit the View 
mode.

Editing Comment Blocks
A comment block consists entirely of text. The Edit Comment Block dialog is a text 
editing window in which you can add, modify and delete the text of a comment block. 
Under GIF Construction Set for Windows , a comment block can include up to 32,767 



characters.

The Format button of the Edit Comment Block dialog will toggle between displaying text
in the conventual chunky Windows font and displaying it in a monospaced font. The 
former is better for editing a lot of text, while the latter is useful if you'd like to create 
formatted comment blocks.

Editing Plain Text Blocks
Plain text blocks consist of text and some information about how to display it. The text 
can be edited the same way comment block text is handled. The following fields define 
how plain text blocks will be displayed:

- Text left and text top: These fields define where the text will appear on your screen, 
relative to the upper left corner of the viewing area. These values are defined in pixels.

- Grid wide and grid deep: These fields define a rectangle in which your text will be 
drawn. A grid ten wide and twelve deep would allow for twelve lines of up to ten 
characters each. Text which doesn't fit in the grid defined by a plain text block is not 
displayed.

- Cell wide and cell deep: These fields define the dimensions of the characters used to 
display text. In theory, a GIF viewer should look at these fields and create a suitable 
monospaced font to display the text in question. In most cases this is not so -- GIF 
Construction Set for Windows included. Most GIF viewers will use a font which is eight 
pixels wide and anywhere from eight to 32 pixels deep.

- Foreground and background: These are the colours used to display the text in 
question. Note that if a plain text block is preceded by a control block which defines a 
transparent colour, one of these colours can become transparent. You can select these 
colours either by clicking on their colour buttons or by using the eyedropper tool to pick 
colours from the previous image block if one is present. The eyedropper tool will not be 
active if there is not at least one image block before the current plain text block.

The View button will display the image preceding the plain text block being edited with 
the text in question superimposed over it. Note that the View buttons in the edit dialogs 
will not display an entire complex GIF file. They'll only display the current block. If your
image does not display correctly, please read the section of this document that deals with 
the About dialog for a discussion of Windows screen drivers. Hit Esc or click the right 
button of your mouse to exit the View mode.

Editing Control Blocks
A control block includes the following fields:

- Transparent colour: If this switch is turned on, one of the global palette colours in 
subsequent image or plain text blocks will be regarded as being transparent by GIF 
Construction Set for Windows when you view a complete GIF file. This means that rather



than displaying areas of this colour, it will allow whatever is underneath the displayed 
image or text to show through. You can select this colour either by clicking on the colour 
button to the right of the switch or by using the eyedropper tool to pick a colour from the 
next image block if one is present. The eyedropper tool will not be active if there is not at
least one image block after the current plain text block.

- Wait for user input: If this switch is turned on, a GIF viewer displaying your GIF file 
will display the next image or plain text block and pause for user input. User input is 
usually a key press or a mouse click.

- Delay: This is the number of seconds a GIF viewer will pause after displaying the next 
image or plain text block. If Wait for User Input is also enabled, the delay can be 
interrupted by a key press. 

- Remove by: This tells a GIF viewer what do with an image after it has been displayed. 
Be careful of the Previous Image option... some GIF viewers have problems with this if 
you ask a really big image to be removed this way.

The View button will display the image preceding the control block being edited with any
transparent effects that you've defined. Note that the View buttons in the edit dialogs will 
not display an entire complex GIF file. They'll only display the current block. If your 
image does not display correctly, please read the section of this document that deals with 
the About dialog for a discussion of Windows screen drivers. Hit Esc or click the right 
button of your mouse to exit the View mode.

Inserting Blocks
You can add blocks to a GIF file with the Insert button of the GIF Construction Set for 
Windows button bar. A dialog will appear to allow you to select the type of block you 
wish to insert. Inserted blocks are always inserted immediately after the currently 
selected block. 

If you attempt to insert an image block into an existing GIF file, a dialog will appear 
prompting you for the file to insert. Images can be drawn from files in the following 
formats:

PNG These are compressed graphics created to replace GIF
MacPaint Monochrome image files from Macintosh systems
GEM/IMG Primarily used by Ventura Publisher
PC Paintbrush PCX The native file format of Z-Soft's PC Paintbrush software
CompuServe GIF Among the most widely used PC image file formats
TIFF    Supports them all, including Group III, IV and LZW
Deluxe Paint/Amiga IFF/LBM Only supports pure IFF files and Deluxe Paint LBM files 
PC Paint Pictor PIC Supports them all, including high colour PIC
Truevision Targa Supports all Targa files
Windows /OS2 BMP/DIB Supports all BMP files, including those from OS/2
Windows 3 RLE Supports most Windows RLE files
Microsoft Paint MSP This is the old monochrome paint format from Windows 2
Halo CUT This is the very obscure Halo cut format
PFS:First Publisher ART Only supports uncompressed ART files



JPEG JPG All JPEG files will be displayed in 256 colours
Sun Raster RAS These are files from Sun unix workstations
HRZ SSTV These are high colour slow scan television files
WordPerfect Graphics WPG Only supports bitmapped WPG files. If your WPG files

do not display they are vector files, and are not supported 
by GIF Construction Set for Windows .

Note that if you import an image from a GIF file using the Insert function, the first image 
in the file will be read, even if the file actually contains multiple images. Use the Merge 
command of GIF Construction Set for Windows, discussed later in this document, for an 
alternate approach to importing images from GIF files.

If you attempt to insert an image which has a different palette from the current global 
palette of your GIF file, a dialog will appear asking how you'd like to handle the new 
image's palette. These are the available options:

- Use a local palette for this image. If you do this, no colour shifts or dithering effects 
will be introduced into the image, but very nasty things may happen if you attempt to 
display this image concurrently with other images in the file. You can't use plain text 
blocks with local palette images. Local palettes are usually not a very good idea for 
conventional display applications. If you attempt to import a true colour image with this 
option, it will be dithered to a 256-colour image internally.

- Use a local grey palette for this image. The image will be converted to grey scale and 
installed with a local palette. All of the foregoing considerations for local palettes still 
apply.

- Remap this image to the global palette. This is a good choice for mechanical images...
drawings and such... and a really bad choice for photographs. Each colour in the source 
image will be replaced by the closest match from the global palette. This will usually 
make photographs look posterized.

- Dither this image to the global palette. This is a good choice for photographs. It will 
give you the best colour match... and usually the most attractive results... with a slight 
loss in detail resolution.

- Use this image as the global palette. This option will only be available if no other 
image blocks currently exist in your GIF file, such as when you create a new file. The 
global palette for the header of the file will be drawn from your imported image. If you 
attempt to import a true colour image with this option, it will be dithered to a 256-colour 
image internally.

- Use it as is. No checking or correction will be performed, and the colours in your 
imported image will fall where they may. This option is useful if you know that certain 
colours in your imported image correspond to colours in the current global palette, such 
as for images created to be overlays with transparent colours. Plan on radical colour shifts
and Andy Warhol's worst nightmare if this is not the case.



If you insert other types of blocks... specifically control, comment or plain text blocks... 
default blocks will be created which you can subsequently edit, as has been discussed.

The 15-bit Quantize option will produce more attractive images if your palette selection 
requires colour matching and remapping. However, it's also pretty slow, especially on 
older machines.

Merging Blocks
The Merge button in the GIF Construction Set for Windows main window will allow you 
to import all the blocks in a GIF file... except for the header block... into the current file. 
They will be inserted starting just after the currently selected block. Image blocks will be 
handled using the same logic discussed previously for inserting individual image blocks...
a dialog may appear prompting you to choose a strategy for handling palette conflicts.

You can use the Merge function to import selected images from a multiple-image GIF 
file. Merge the whole file and delete the blocks you don't need.

Deleting Blocks
You can delete any block save for the header by selecting it and clicking on the Delete 
button. Note that once a block is deleted, it's gone for good.

Viewing GIF Files
The View button in the main window of GIF Construction Set for Windows will display a
GIF file using a fully compliant viewing function. The viewing area, as defined by the 
screen dimensions of the file header, will be centred in the main window of your screen if
it's bigger than your screen. Each displayable block will appear in the order it's defined in
the GIF file. You can terminate the display any time you like by clicking the right button 
of your mouse or hitting the Esc key.

The background of the view mode may appear dithered on systems with colour mapped 
screen drivers. This can be changed using the Setup dialog of  GIF Construction Set for 
Windows, as discussed elsewhere in this document.

If the screen dimensions defined by a GIF file's header block are greater than the 
dimensions of your screen, scroll bars will appear to allow you to pan over the displayed 
image.

Creating New GIF Files
To create a blank GIF file, select New from the File menu. A blank GIF file always 
includes a header block. You can add blocks to a new GIF file with the Insert and Merge 
functions.

Opening and Saving GIF Files
Any GIF 87a or 89a file can be opened into GIF Construction Set for Windows. Files 
created with GIF 87a headers will be converted internally to GIF 89a files. As discussed 



previously, you can open a GIF file either by selecting the Open item from the File menu 
of GIF Construction Set for Windows or by double clicking on the name of a GIF file in 
the main list of the application window. It's possible that extremely complex GIF files... 
those with lots of blocks... may not open completely. See the section of this document 
dealing with the Setup dialog for information about getting around this.

The Save and Save As functions of the File menu will save your current GIF file to disk. 
All GIF files written by GIF Construction Set for Windows will have GIF 89a headers. 

If you enable the Write Thumbnail option of the Save As dialog, each file written by GIF 
Construction Set for Windows will be accompanied by a thumbnail. Thumbnails are 
stored in files with the extension .THN. As such, the thumbnail for PICTURE.GIF would 
be called PICTURE.THN. The thumbnails created by GIF Construction Set for Windows 
are compatible with those used by Graphic Workshop for Windows and other Alchemy 
Mindworks applications which support thumbnails. 

Thumbnails will appear in the application window of GIF Construction Set for Windows 
if you select a GIF file prior to opening it. A thumbnail always represents the first image 
in a multiple-image GIF file.

Unregistered copies of GIF Construction Set for Windows will add a comment block to 
any GIF file you save. This comment block will not appear once you register GIF 
Construction Set for Windows.

Cutting, Copying and Pasting Blocks
You can cut or copy the current block of a GIF file to the Windows clipboard using the 
appropriate items of the Edit menu. A block copied to the Windows clipboard will have 
its block structure stored as hexadecimal data defined in OEM text. Plain text and 
comment blocks will have their text stored as conventional Windows text. Image blocks 
will have their image information stored as conventional Windows device-independent 
bitmaps.

It's a really bad idea to mess with the OEM text objects copied from GIF Construction 
Set for Windows and then paste them back into GIF files.

You can copy a bitmap from another application onto the clipboard as a device-
independent bitmap and paste it into a GIF file through GIF Construction Set for 
Windows. It will be given an image block on the way in, which you can subsequently edit
if you like.

Closing GIF Files
If you select the Close item of the File menu of GIF Construction Set for Windows, the 
current GIF file will be closed and the list in the main application window will revert to 
showing you the names of all the GIF files in your current directory. Opening a new GIF 
file automatically closes the current one.



The Setup Dialog
The GIF Construction Set for Windows Setup dialog can be called up through the Setup 
item of the File menu. It includes the following fields.

- Display Interlaced: If this switch is enabled, image blocks with interlaced images will 
appear in interlaced order.

- Draw Frame Guides: It this switch is enabled, purple guides will appear to define the 
image area of a GIF file being viewed using the View buttons of the edit dialogs. Guides 
do not appear in the main View function.

- Use Image Offsets: If this item is not enabled, images will be displayed centred on 
your screen, rather than where the position fields of their image blocks say they're 
supposed to be. There are few good reasons for doing this.

- Dither View Background: This item is ignored on systems with screen drivers that can 
display more than 256 colours. If your current Windows screen driver can display 256 or 
fewer colours, setting this switch on will cause the background of the main View mode to
be dithered to approximate the setting of the background field of the header block of the 
GIF file being displayed. Setting it off will cause the closest match from the current 
global palette to be used, allowing for Window's somewhat funky palette management 
strategy. See the section of this document which deals with the About dialog of GIF 
Construction Set for Windows for information about how to determine the number of 
colours your current Windows screen driver can display.

- Interlace Delay: This is the number of milliseconds GIF Construction Set waits after it 
display one line of an interlaced image.

- Dither contrast and dither brightness: These values only affect monochrome 
dithering in the image block import function. If you attempt to import a colour image into
a monochrome GIF file, it may be dithered to two colours, depending on the palette 
option you select. These fields can be used to fine tune the dithering.

- Maximum blocks: When a GIF file is opened in GIF Construction Set for Windows, a 
fixed number of blocks will be allocated for it. If you exceed this number, no new blocks 
will be accepted. The default value, 64, will suffice for all but the most complex GIF 
files. You can increase this number if you run out of blocks or if GIF Construction Set for
Windows refuses to open a very complex GIF file because it has more than 64 blocks. 
Note that changes to this field will not take effect until the next time you open or create a 
GIF file. If you run out of blocks you must save your current GIF file, change this field 
and open the file again. 

Setting the Maximum Blocks field higher than it needs be will tie up excessive memory 
and probably slow down Windows and applications running under it.

Registration name: You can turn a shareware copy of GIF Construction Set for 



Windows into a registered copy by entering your name in the registration field and 
clicking on Accept. A dialog will appear prompting you for a reference from Steven 
William Rimmer's novel The Order. Each reference is one word, and does not include 
any spaces or punctuation. References have been chosen to be near the tops of pages to 
cut down on the number of lines you'll have to count. The reference you're asked for will 
be determined by a checksum of the characters of your name.

Once you have successfully registered GIF Construction Set for Windows, you will no 
longer see the beg notice when the application terminates and the extra comment block 
added when you save a file will not appear. In addition, you'll have great karma and our 
leather winged demon of the night won't regard you as a handy source of protein... 
something well worth considering.

Note that the actual registration requirements for GIF Construction Set for Windows are 
that you buy and read this book. Also note that if you have a hard drive crash or are 
otherwise required to reinstall GIF Construction Set for Windows, you will need your 
copy of  The Order to complete this field.

The About Dialog and Windows Screen Drivers
The About button in the button bar of GIF Construction Set for Windows will display a 
beg notice for unregistered versions and a grey dialog with a unicorn for registered 
versions. The latter dialog will also tell you several useful things about your computer, 
such as the amount of memory Windows thinks is free and the number of colours your 
current Windows screen driver can display without dithering. The latter is very 
important... if you attempt to view a 256-colour GIF file on a system with a sixteen-
colour driver installed, the resulting images will look posterized and ugly. This does not 
mean that GIF Construction Set for Windows is misbehaving... you must update your 
Windows screen driver to see 256-colour images correctly. 

If you have an unregistered copy of GIF Construction Set for Windows, you can see the 
latter dialog by holding down the shift key and clicking on the Ok button in the beg 
notice dialog. You should do this if you are not seeing 256-colour images displayed 
correctly to check if the problem is with your screen driver.

As an aside, this works the other way, too... should you have reason to wish to see the 
unregistered beg notice dialog after you've registered, hold down the shift key and click 
on the Ok button.

Secrets, Tricks and Common Applications
Here are a number of useful things you might want to know about using GIF 
Construction Set for Windows.

Creating transparent GIF files: A transparent GIF file is one in which an image block 
displays with one transparent colour. Anywhere the transparent colour exists in the image,
no pixels will be painted and whatever was visible before the image appeared will show 
through. To create a transparent GIF file, add a control block before the image block you 



wish to include transparent areas. Enable the Transparent Colour switch in the control 
block and set the transparent colour to correspond to the colour of the areas of the image 
you wish to appear transparent. 

Note. Read this. Very important. Definite demon bait if you don't. Transparent GIF files 
only display with their transparent elements under fully compliant GIF viewers. This 
includes GIF Construction Set for Windows, most World Wide Web Browsers and a 
limited number of other GIF viewing applications. Most applications that just display 
pictures will ignore transparency  information in GIF files. This includes our own 
Graphic Workshop software, for example. If your transparent GIF files don't seem to be 
transparent in some applications, the problem is not with GIF Construction Set for 
Windows or your GIF files. 

Creating magic graphic logos: You can create a GIF file that has a main image and a 
smaller secondary logo which appears, sticks around for a moment and goes away. In 
addition to the main image block, you will need a control block followed by a smaller 
secondary image. The secondary image can have a transparent background... this looks 
very slick. Set the control block up with whatever transparent colour you require, a brief 
delay, the user input flag turned on and the Remove By field set to Previous Image.

Creating plain text with a drop shadow: This looks very slick. It involves two plain 
text blocks and two control blocks. Each of the plain text blocks should contain the same 
text. The second one should be slightly lower and to the right of the first one... two pixels 
in each direction is usually about right. The second and optionally the first plain text 
block should be set up so their background colours are transparent, as defined by their 
control blocks.

Automatically viewing an image when it's loaded: Hold down the shift key when you 
double click on a GIF file name in the main application window of  GIF Construction Set
for Windows and the image will be loaded and then immediately viewed.

Using GIF Construction Set for Windows as a GIF viewer for other applications: If 
you run GIFCON.EXE, the executable file for GIF Construction Set for Windows, with 
the path to a GIF file as its command line argument, it will automatically load the 
indicated file just as if you'd explicitly loaded it by clicking on it from the main 
application window. If you append /V to the file name, it will automatically load and 
view the file. If you append /V/Q to the file name, it will load the file, view it and then 
quit back to the calling application as soon as you hit Esc or click with the right button of 
your mouse. You can prevent it from quitting in this situation by holding down the shift 
key when you exit the view mode. 

GIF Construction Set for Windows makes a powerful GIF viewer for World Wide Web 
browsers.

Contacting Alchemy Mindworks Inc.
You can contact us by mail by writing to us at:



Alchemy Mindworks Inc.
P.O. Box 500
Beeton, Ontario
L0G 1A0
Canada

We will attempt to answer questions from unregistered users who write
to us to the extent that their answers are needed for you to fully 
determine whether this software will suit your requirements. 

You can reach our technical support line by phone... see the section of 
this document which deals with technical support.

We can also be reached through the Alchemy Mindworks bulletin 
board. It's available twenty-four hours a day at 1-905-936-9503. As of 
this writing, the protocol was 300, 1200 or 2400 baud, or 9600 or 
14,400 baud v.32bis, eight data bits, no parity and one stop bit. 

The bulletin board always has the most recent versions of all our 
shareware on it, plus bug fixes, drivers and other relevant information. 
It only exists to support Alchemy Mindworks' shareware... it does not 
have a general file area.

If you encounter problems with a file, you're welcome to upload the 
errant file to our bulletin board. Actually, you can upload any picture 
files you like to the board... we enjoy getting pictures.

If you have a question about GIF Construction Set for Windows, feel free to 
leave it on the bulletin board. We try to answer all questions within 
twenty-four hours. Note that you must call back to retrieve your 
answer... please don't ask us to phone you or to leave the answer on 
another bulletin board.

Our CompuServe address is 70451,2734. Our Internet e-mail 
address as of this writing is alchemy@accesspt.north.net. We will at 
our discretion answer reasonable questions by e-mail. Please do not 
leave credit card information on the Internet.

You can find the current version of GIF Construction Set for Windows and our 
other applications on the Internet at our FTP site 
uunorth.north.net:/pub/alchemy.

You can download current versions of our applications, keep up to date 
with version changes and find other interesting bits at our World Wide 
Web server 



http://uunorth.north.net:8000/alchemy/alchemy.html.

We ask that in contacting us you appreciate that we are a small 
company with limited resources. If you have not registered this 
software we will not tell you to go to hell, but please don't ask us for 
half an hour of free technical support. We have not built the price of 
technical support into the cost of GIF Construction Set for Windows, as few 
users require it. We believe very strongly in not making everyone pay 
for something that only a small group needs. If our various 
governments felt the same way, our various economies wouldn't be in 
the midst of melting down.

Support this Software
If you like GIF Construction Set for Windows and find it useful, you are 
requested to buy and read Steven William Rimmer's new novel The Order, ISBN 
1-895268-02-8, published by Jam Ink Publishing. See BOOKWARE.WRI for more 
information. This will allow you to shut off the begin notice which appears
when you exit GIF Construction Set for Windows. More to the point, though, 
it'll make you feel good. We've not infested GIF Construction Set for Windows
with excessive beg notices, crippled it or had it verbally insult you after
ten days. We trust you to support this software if you like it.

If you want to see additional features in GIF Construction Set for Windows, 
support it. If we had an Arcturian mega-dollar for everyone who has 
said they'd most certainly register one of our applications if we'd add 
just one more thing to it, we could buy ourselves a universe and retire.

Finally, as mentioned at beginning of this file, should you fail to support
this program and continue to use it, a leather winged demon of the 
night will tear itself, shrieking blood and fury, from the endless caverns
of the nether world, hurl itself into the darkness with a thirst for blood 
on its slavering fangs and search the very threads of time for the 
throbbing of your heartbeat. Just thought you'd want to know that.

If you can't find The Order locally, you can order it by calling 1-800-263-1138 or 1-905-
936-9500. The cost as of this writing is $6.99 plus shipping ($2.50 in Canada, $3.00 to 
the US, $4.50 international).   This order service can accept payment by Visa, Mastercard 
or American Express. See BOOKWARE.WRI for other ordering options.

Technical Support
Technical support is available at 1-905-936-9501, 10:00am to 5:00pm 
EST most business days. If you encounter our answering machine... it 
does happen occasionally... please try back later. One of the 
considerations in offering very low cost software is that we are
unable to return calls for technical support.



Callers who are rude, abusive or pig-headed with our technical support 
staff will wind up as demon-chow. See the section on Registration 
elsewhere in this document.

Please do not call our 800 number for technical support. The people 
who answer our sales line can put a credit card machine into warp 
drive, but they know less about software than most cats know about 
quantum mechanics.

We are also happy to provide you with technical support by e-mail, as 
discussed earlier in this document.

Books
Steven William Rimmer's new novel The Order is available at better book shops, or 
directly through Alchemy Mindworks. It's a tale of fertility magic, alchemy, secret 
societies, pagan lust and Victorian nasties... all holed up in a castle in the Scottish 
highlands about a hundred years ago. It costs $6.99... see BOOKWARE.WRI or the  
order form accompanying this software for more information.

If you use Alchemy Mindworks software, you might find the following books by Steven 
William Rimmer useful as well. You can browse a listing of these books and Steve's 
fiction at our World Wide Web server on the Internet. It's at 
http://uunorth.north.net:8000/alchemy/alchemy.html

Planet Internet, published by Windcrest/McGraw Hill, is a guide to the pubs, curio 
shops, back alleys and brothels of the Internet. It's a wealth of unusual and infrequently 
heard-of newsgroups, FTP sites and other resources on the net. It also includes some of 
the wildest graphics to be found on paper... parental guidance is advised. This is the book 
to have if you want to rip out onto the information superhighway and have a really good 
time.

Advanced Windows Multimedia Programming, published by Windcrest/McGraw Hill,
offers an extensive resource for high end multimedia applications. It includes example 
source code for displaying and animating bitmaps, working with a joystick, playing and 
creating MIDI files, modifying WAV files, working with the AVI extensions in the 1.1 
VFW development kit and a lot more. 

Constructing Windows Dialogs, published by Windcrest/McGraw Hill, will provide you
with the techniques, secrets and dirty tricks to make the user interface of your Windows 
applications state of the art. Included are discussions of the standard Windows controls, 
the BWCC and CTL3D custom control libraries, multimedia, using graphics and creating 
your own custom control libraries. 

Canned Code, published by Windcrest/McGraw Hill, is a collection of DOS and 
Windows programming tricks accumulated through years of real world application 
design. Included are bits of code to do high speed screen access, display a PCX file, 



access a dBASE DBF database, draw recursive graphics, play music, draw a maze, create
fireworks, display a WordPerfect document, implement a text filter and many more useful
and otherwise badly documented functions.

Windows Multimedia Programming, published by Windcrest/McGraw Hill, includes 
complete C language source code for Windows applications to play wave and MIDI files,
display and animate bitmaps, read Kodak Photo-CD images through the Kodak PCD 
libraries, play compact disc audio tracks from a CD-ROM drive and display Video for 
Windows AVI files. The source code for the applications in the book, along with about a 
hundred megabytes worth of example graphics, sounds, scores and movies, plus six 
compact disc audio tracks of celtic music, are included on a CD- ROM.

If you're interested in writing programs which use graphics, you'll find everything you 
need to know in Bitmapped Graphics, second edition. It's published by 
Windcrest/McGraw Hill, (TAB book 4266). It features code to pack and unpack 
MacPaint, IMG, PCX, GIF and TIFF files, as well as chapters on screen drivers, dithering
and printing.

An additional book on this subject, Supercharged Bitmapped Graphics, (TAB Book 
4102), discusses the GIF 89a, WordPerfect, BMP, IFF/LBM, TGA, MSP, 24-bit PCX and 
colour TIFF file formats, as well as such subjects as colour dithering and colour printing.

Super VGA Graphics, published by Windcrest/McGraw Hill, includes source code to 
read and write GIF and PCX files, and to do extensive graphics in the sixteen, 256 and 
32,768 colour screen modes of popular super VGA cards. There is a chapter about 
printing graphics to a variety of printers... ranging from simple dot matrix printers though
laser printers to colour ink jet printers. The book also includes a chapter about writing 
animated super-VGA arcade games.

If you'd like to write applications which use menus, icons, windows and all the other 
paraphernalia of a graphical user interface, you might find the book PC Graphical User 
Interfaces handy. It's published by Windcrest/McGraw Hill (TAB Book 3875). It 
includes the C source for a complete graphical user interface library, related code to 
manage fonts and bitmaps and a tiny paint program. 

Windows Bitmapped Graphics, published by Windcrest/McGraw Hill, deals with the 
most popular image file formats in a Windows environment. It also discusses printing, 
viewing and dithering images in Windows applications.

A complete discussion of graphic file formats for use in word processing documents and 
desktop publishing chapters can be found in The Graphic File Toolkit, published by 
Addison-Wesley. This is an invaluable reference for anyone who wants to use graphic 
files but does not want to become a programmer in the process.

Corel Draw It, Published by Addison Wesley, is the essential guide to Corel Draw 4.0. 
Streamlined to take you from a standing start to complete mastery of Corel Draw in as 



short a time as possible, Corel Draw It offers a lucid explanation of lines and fills, colour,
type and typography, bitmaps, importing and exporting, special effects and numerous 
other areas of Corel Draw.

If your local bookstore doesn't have these books, they can be mail or phone ordered from 
Christies of Cookstown, P.O. Box 392, Cookstown, Ontario L0L 1L0, Canada. Their 
phone number is 1-705-458-1562. It has a FAX machine on it after hours. As of this 
writing, they're open seven days a week.

Bundling GIF Construction Set for Windows 
If you'd like to include GIF Construction Set for Windows with your product, 
please get in touch with us. We have several ways to help you do this 
so your users get the most out of our software and we won't have to 
set our leather winged demon of the night on 'em.

Shareware Distributors
We will, at our discretion, send out disks of our shareware applications 
to shareware distributors. Alternately, you can download the current 
versions of our applications from CompuServe in the GRAPHSUPPORT  
forum or from our bulletin board at 1-905-936-9503. 

We encourage you to use our bulletin board, as it will allow you to keep
your copies of our applications up to date.

If you obtain current copies of our shareware, you have our permission 
to distribute them under the following terms. No written permission 
from us is required if you abide by these terms.

That nothing be added to, deleted from or changed in the archive 
files which contain our packages. This includes adding ZIP file 
comments to them.

That our shareware is not included in or bundled with other 
hardware or software without our written permission.

That no printed documentation regarding our shareware is included 
with the package without our written permission.

That hard copy explaining that our packages are shareware is 
included with the disks.

That no more than $10.00 (US) be charged for the distribution of 
whatever package our applications are part of. If you will be 
charging more than this, please get in touch with us for bundling 
rates.



You do have our permission to copy the ZIP files from our quad density 
disk to multiple lower density disks for distribution.

Please note that if you would like to distribute GIF Construction Set for 
Windows in "rack" packaging, that is, in a store rather than directly from 
a shareware distributor, we request that you contact us for permission 
to do so. We will require a proof copy of the packaging you intend to 
use prior to giving our consent for rack packaging.

Revision History
1.0d -- Added PNG support for the file import function. Generally tidied 
things up under Windows 95. Added an option to display interlaced 
images in interlaced order. Fixed a bug that caused GIF Construction 
Set to create illegal four- and eight-colour GIF files. Added an 
eyedropper tool to the plain text and control block dialogs.

1.0c -- Fixed a problem that caused transparent monochrome GIF files 
to display incorrectly on some displays. Added spin buttons to some of 
the dialogs. Fixed a problem with setting colours in the plain text dialog
after viewing. Added a version display for unregistered copies.

1.0b -- Fixed a bug which caused some GIF files to appear to only have 
two colours, when in fact they had complete palettes.

Other Alchemy Mindworks shareware
The following are the other shareware packages we have available as 
of this writing. Our newsletter, available for the asking, will list all the 
current ones.

Graphic Workshop for DOS -- release 7.0
This is the last word in image programs. It converts, prints, views, 
dithers, transforms, flips, rotates, scales, crops, colour adjusts, 
catalogs, quantizes and wreaks special effects on MacPaint, 
GEM/Ventura IMG, PCX, GIF, TIFF, WPG, MSP, IFF/LBM, BMP, RAS, 
JPEG, HRZ, RLE, Halo CUT, Targa, EXE, TXT and EPS files. It drives 
CGA, Hercules, EGA, VGA and pretty well all super VGA cards. It will 
drive PostScript and LaserJet Plus laser printers, colour PostScript 
printers, colour inkjets and most dot matrix printers. It features 
batch processing, extended and expanded memory support, an 
intuitive user interface and easy to follow menus. It allows you to 
convert colour image files into superb black and white clip art for 
desktop publishing, among other things. The registered version 
includes a powerful VGA and super-VGA screen capture utility.

Pagan Daybook for Windows -- release 1.1
This is a small Windows application which will help you keep track of



the pagan calendar. Never again be at a loss to know when the 
summer solstice occurs, or when to celebrate the festival of 
Fortunalia. It's considerably more interesting than a calendar that 
tells you when the bank holidays and long weekends fall. The Pagan 
Daybook is being offered as bookware... the cost of registration is to
buy Steven William Rimmer's new novel The Order. 

Pagan Daybook for DOS
This is a DOS text-mode implementation of the Pagan Daybook for 
Windows. It's also bookware, and if you register the Windows 
version you'll be registered for this one too.

QuickShow Light for Windows
QuickShow for Windows is a powerful, easy to use Windows 
multimedia slide show. It will display graphics in any mixture of the 
following formats: MacPaint, IMG, PCX, GIF, JPEG, TIFF, WPG, MSP, 
IFF/LBM, BMP, RLE, Halo CUT, Targa, ART, HRZ and Photo CD. Special
effects include WAV, MIDI and AVI files. QuickShow is fast, easy to 
use and can create slide shows which are as simple or as complex 
as you want them. QuickShow is being offered as bookware... the 
cost of registration is to buy Steven William Rimmer's new novel 
The Order. 

Graphic Workshop for Windows (release 1.1)
Offering the same functionality as Graphic Workshop for DOS, the 
Windows implementation of this package offers a traditional 
Windows interface, multitasking and lots of things to click on. It 
converts, prints, views, dithers, transforms, flips, rotates, scales, 
crops, colour adjusts, scans, quantizes, catalogs and wreaks special 
effects on MacPaint, GEM/Ventura IMG, PCX, GIF, TIFF, WPG, MSP, 
IFF/LBM, BMP, RLE, BGA, CDR bitmaps and previews, CPT, FITS, 
JPEG, ART, RAS, HRZ, FLC, FLI, MOV view only, WMF, AVI, ICO, CGM, 
HPGL, CLP, CUT, Halo CUT, Targa, text and EXE picture files. Graphic
Workshop for Windows will display and print on any card and printer
respectively that can be driven by Windows. It features batch 
processing, an intuitive user interface and easy to follow menus. 
Includes several unicorns.

GrafCat for Windows
GrafCat for Windows is an application to print paper catalogs of 
graphic files. It will print some or all of the images in a directory 
with anywhere from six to fourty-eight images to a page in high 
resolution thumbnails. It will drive any printer that Windows has 
drivers for in two-colour dithered monochrome, 256-level grey scale 
and 24-bit true colour. GrafCat's output is a very convenient way to 
keep track of lots of images, handle proof pages for book 



manuscripts and deal with other situations wherein you
want to print a lot of pictures. It works with most of the file types 
supported by Graphic Workshop for Windows, including PCX, GIF, 
JPEG, Photo-CD, WMF and TIFF. GrafCat for Windows is being offered
as bookware... the cost of registration is to buy and read Steven 
William Rimmer's new novel Wyccad.

Multimedia Workshop Light for Windows
Multimedia Workshop Light for Windows is an easy to use Windows 
WAV, MIDI and AVI file manager. It allows you to audition, queue, 
rename, delete and investigate multimedia files. Multimedia 
Workshop Light is being offered as bookware... the cost of 
registration is to buy Steven William Rimmer's new novel The Order.

Image Gallery (release 1.1e)
Image Gallery is a visual database to help you keep track of a large 
number of image files quickly and effectively. It will create database 
files... galleries... of any combination of bitmapped image files, 
displaying them as small ``thumbnail'' images. It works with all the 
file formats supported by Graphic Workshop, with the exceptions of 
EPS, EXE and TXT. You can search a gallery visually or by key words.
Each entry in a gallery supports key word and comment fields, as 
well as the dimensions, location and other specifics of each image. 
You can also print all or part of a gallery, producing hard copy 
catalogs of your images when you need them. Image Gallery will 
run with any VGA card. It uses a Microsoft compatible mouse and 
will drive any PostScript or LaserJet Plus compatible laser printer, 
and most dot matrix printers. Release 1.1 includes a full colour view
function, exporting, colour thumbnails and multiple selection.

Desktop Paint 256 (Release two)
This is a complete rewrite of our popular super VGA paint package. 
Desktop Paint 256 is a powerful painting application. It will let you 
create and edit pictures stored in the MacPaint, GEM/Ventura IMG, 
PCX, GIF, TIFF, WPG, MSP, IFF/LBM, BMP, Halo CUT, and Targa 
formats. It features a rich selection of drawing and image 
manipulation tools, XMS and EMS support to work on large images 
and a user friendly interface. Looking very much like monochrome 
Desktop Paint in colour, it's a powerful application which will be 
equally useful for picture collectors, artists and desktop publishing 
users. It supports Paradise (and compatibles), Headland Video 7, 
Tseng Labs 4000 series cards, Trident cards which use 8900 series 
chips, Oak Technologies cards, ATI VGA Wonder cards and all cards 
with VESA capabilities. Note that you must have one of these super-
VGA cards to use Desktop Paint 256... it does not run in the 
standard 320 by 200 pixel "standard" VGA mode. Desktop Paint 256



requires a Microsoft-compatible mouse.

Desktop Paint 16
Desktop Paint 16 is a VGA paint package for use with images having
up to sixteen colours. As with the monochrome implementation of 
Desktop Paint, it will read and write image files in the MacPaint, 
GEM/IMG, PCX files, GIF, TIFF, WPG, MSP, IFF/LBM, BMP and PIC 
formats. It has EMS and XMS support to handle images of virtually 
any size, an intuitive user interface and a wide selection of image 
creation and manipulation tools. Desktop Paint 16 can utilize fonts 
from many other sources, including Ventura Publisher, Macintosh 
FONT and NFNT resources and Windows FNT files. It requires a VGA 
card and a Microsoft- compatible mouse.

Desktop Paint (Release three)
Desktop Paint is a powerful monochrome paint package fine tuned 
for use with desktop publishing applications. It will read and write 
image files in all the formats Graphic Workshop supports with the 
exceptions of EPS and RLE. It has EMS and XMS support to handle 
images of virtually any size, an intuitive user interface and a wide 
selection of image creation and manipulation tools. Desktop Paint 
can utilize fonts from many other sources, including Ventura 
Publisher, Macintosh FONT and NFNT resources and Windows FNT 
files. Desktop Paint requires a Microsoft- compatible mouse.

GrafCat (Release 3.1)
GrafCat prints a visual catalog of your image files, with fifteen or 
sixteen pictures to a page, depending on the image orientation you 
choose. It supports all the file types that Graphic Workshop handles,
and will drive any PostScript or LaserJet Plus compatible laser 
printer, including LaserJet II and LaserJet III series printers. This is a 
complete re-write of GrafCat... it now supports a file finder screen 
like the one in Graphic Workshop and numerous print options. It has 
an internal view mode like Graphic Workshop, and it can create 
thumbnail catalog graphics.

If you can't obtain them from the usual sources of shareware, they're 
available from us for $40.00 each preregisterd (with the exception of 
GIF Construction Set for Windows and the Pagan Daybook). They're also all 
available for downloading from our bulletin board at 1-905-936-9503 
and from our FTP site and WWW page, listed elsewhere in this 
document. We can send you an evaluation disk set with all our 
applications on it for $10.00.

Legal dogma
Neither the author nor Alchemy Mindworks Inc. assumes responsibility for any damage 



or loss caused by the use of these programs, however it comes down. If you can think of a
way a picture program can cause you damage or loss you've a sneakier mind than any of 
us.

All the registered trademarks used herein are registered to whoever it is that owns them. 
This notification is given in lieu of any specific list of trademarks and their owners, 
which would not be as inclusive and would probably take a lot longer to type. 

If you register GIF Construction Set for Windows , we will assume that you are doing so 
having tested the shareware version and ascertained that it's suitable for your hardware 
and requirements. We cannot provide refunds for shareware registration if you 
subsequently change your mind.

The JPEG reader in IFMT.DLL is based on code from the Independent JPEG Group. 
Parts of the TIFF reader in IFMT.DLL is based on code by Sam Leffler.

Portions of the PNG code were written by Jean-loup Gailly and Mark Adler.

GIF is a trademark of CompuServe.

GIF Construction Set, QuickShow, Multimedia Workshop for Windows, Pagan Daybook,
Graphic Workshop, Desktop Paint, Image Gallery and GrafCat are trademarks of 
Alchemy Mindworks Inc.

That's it...


